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ArcMap Tutorial 1.0 
 

1.1 – Loading the Landsat and SAMB Images  
1.2 – Adjusting Image Contrast and Changing Band Combinations 
2.1 – Digitizing the MUC Land Cover Classes 
2.2 – Attributing the MUC Land Cover Classes 
 
Tutorial Objectives: Become familiar with several important ArcMap features, and 
create a digital GLOBE Land Cover Map. 
 
ArcMap is the ArcGIS tool used to create and visualize various types of geographic data, 
including maps and map features (Fig. 1). ArcMap is also used to resolve basic 
geographic questions of location, size, juxtaposition, and can even answer “what if?” 
questions - geographic modeling scenarios. One of ArcMap’s most powerful features is 
its ability to be customized for specific, unique types of  analyses, via its customizable 
interface.  
 

 
 
Figure 1.  ArcMap, showing the Table of Contents in the left pane and the Landsat image etm+1733_2001-
9-17.img in the Display Window.   
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Lesson 1.  Viewing Digital Geographic Data in ArcMap 
 

1.1) Loading the Landsat and SAMB Images 
 
Browse to and boot ArcMap using the Start button (Start/Programs/ArcGIS/ArcMap).  
A small dialog box will appear, asking you to make a selection (Fig. 2). We will click the 
radio button to select “A new empty map”. 
 

 
 
Figure 2. The ArcMap Start dialog box.   
 
Once we’ve created a new map file by clicking ‘OK’, we can browse to our images.  To do 
this, we click on the “Add Data” icon , opening the Add Data dialog box that permits 
browsing to our data files.  Notice that ArcMap uses ArcCatalog Connections. Browse to 
the Landsat image etm+1733_2001-9-17.img and add it. The Display Window should 
resemble Figure 1. 
 
Before we learn about image enhancement, let’s add the GLOBE 15km x 15km subscene 
and the 5km x 5km subscene that we’ll ultimately be using for our MUC land use map.  
These will help us understand how image contrast enhancement works.  
 
Click the Add Data icon and add south_middle_globe.img, followed by the image named 
south_middle_5x5_km.img. All three images should now show up in the Table of 
Contents.  
 
Let’s arrange them by size, with the entire scene underlying the 15km by 15km scene, 
with the 5km by 5km scene as the “top” layer.  This is done simply by selecting and 
dragging the files in the Table of Contents. 
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Notice that if you click the small box immediately to the right of the ‘+’ sign for each 
image, you can turn the image display on or off. If you click the ‘+’ sign, it will display 
(‘-‘) or hide (‘’+’) the image’s band numbers and display assignments (Fig. 3). Note that 
these are only the three bands that are displayed on the screen, not the total number of 
bands that could be used in a display. We’ll learn more about the latter idea in the next 
section. 
 

 
 
Figure 3.  The ArcMap Table of Contents showing the color display assignments for the near-infrared band 
(4), the red band (3), and the green band (2).  
 

1.2) Adjusting Image Contrast and Changing Band Combinations 
 
Now that all three Landsat images are added, let’s force the computer to display them so 
we can view them as individual, subsetted files. To do this, we’ll need to represent the 
pixel data values, the DN’s or “digital numbers”, differently.  We do this by altering the 
DN’s as they are displayed by the computer (but we don’t actually alter the pixel values 
in the data, just their display value on the compute screen – this is an important point). 
We do this by “mapping” the underlying (original) DN values to “new” display values.  
 
First, select the underlying scene (etm+1733_20019-17.img), right-click and draw down 
to “Properties…”, click the “Symbology” tab (Fig. 4). 
 

 
 
Figure 4. The Symbology dialog box in the Layer Properties menu.  
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Note that the Layer Properties Symbology shows our image as a 4,3,2 color-IR image 
(the small image in the lower left always shows a color-IR example, regardless of the 
band combinations). What we’ll do is view how ArcMap displays the image, by noting 
the type of stretch (Standard Deviations) and ‘n’ value.  Click on the ‘Type’ menu and 
you’ll a variety of choices (None, Custom, Standard Dev., etc.), representing the various 
types of functions one can apply the selected image DN values for each band.  The 
frequency distribution of the DN values of the data in the Near IR band, displayed using 
the red color gun on the computer monitor, looks like this: 
 

All that has been done here is a simple 
remapping of the original pixel values to 
‘new’ values for display purposes (the new 
values are being written to what’s called a 
“Look Up Table”, or LUT). We’ll 
manually set them back to their original, 
“unstretched” values. But first, let’s 
examine the stretch on the green and blue 
bands.  
 
Since we know that the x-value is the 
original pixels value and the y-values are 
the ‘new’ or stretched values, let’s map the 
y-values back to the original values using a 
1:1 mapping. 

Figure 5. The frequency distribution of DN values in the near-IR band, band 4, displayed using red. 
 
Click on the small box on the x-axis and drag it t the origin. Now, select the small box at 
the top, and drag it to the upper right corner. What you’ve jus done is created the function 
x=y. The two frequency distributions should overlap. Let’s do that for all three bands and 
view the image as it looks without a contrast stretch.  Now, let’s change the contrast on 
all three images so we can see each clearly (Fig. 6). 
 

 
 
Figure 6.  All three Landsat images, each displayed using a different contrast stretch. 
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Contrast stretching is useful for a variety of visual analysis techniques. Another technique 
we can use extract information from a Landsat scene is changing the band combinations. 
Whereas the existing color-IR image shows the vegetation quite well, there are other 
bands and band combinations that help to distinguish other features. A common 
combination is 5,4,3. Landsat band 5, the mid-infrared band (1.0 to 1.9 Ium, 
micrometers) is set to red, and near-IR is set to green.  This is an effective combination 
for distinguishing grasslands (agricultural hay fields, in our area) from forest.  The 
visible, or 3,2,1 is also useful for this distinction.  We can try these combinations on 
urban land uses and assess how effective they are at distinguishing, for instance, bare soil 
from asphalt. 
 

2.1 Digitizing the MUC Land Cover Classes 
 
After we’ve examined the GLOBE Landsat image and we’ve begun to see some of the 
ways we can extract information about surface features, it’s time to begin our Land Cover 
Mapping exercise. The idea is to create a digital version of the manual land cover map 
described in the Land Cover – Biology investigation (see Manual Land Cover Mapping 
Protocol in the 2003 Land Cover / Biology Investigation manual).  We’ll use the Landsat 
subscene and the  SAMB aerial photographs to map MUC land cover classes. 
 
First, add the index (Mon_Co_index_projected.img) so that we can see the aerial images 
we’ll need for accurate mapping.  Then add the GLOBE 15km x 15km scene, then add 
the six SAMB images over it, finally add the 5km x 5km scene. The display window 
should look like this (Fig. 7): 
 

 
 
Figure 7. The ArcMap Display window showing all four data sets, ready for MUC class digitizing. 
 
We begin our digitizing exercise by adding the shape file that we created in ArcCatalog. 
Click the ‘Add’ button and browse to the shape file directory. Locate LandCover.shp and 
double-click; it should then show up in the Table of Contents window.  
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Under the main ArcMap menu there should be a secondary menu showing ‘Editor’ in the 
upper left (if not, add it by browsing to View > Toolbars and selecting Editor so that the 
Editor tem is checked).  Notice that, although you’ve added the shape file, nothing shows 
up in the Display window – that’s because we’ve essentially opened an empty file; it has 
the required associated files (the .prj, .dbf, and .shx files), yet has no polygon features and 
associated geographic reference data. That’s what we’ll be creating in this exercise. 
 
Now let’s begin digitizing our land use cover classes (to review the cover classes, see the 
MUC Guide).  Begin by selecting ‘Create New Feature’ in the Task drop-down menu 
(Fig. 8). Ann altenative is t use Auto-Complete-Polygons (we’ll try this in a moment). 
 

 
 
Figure 8. Begin digitizing the MUC classes using the Editor’s ‘Create New Features’ task. 
 
Grab the pencil icon   and note that your pointer becomes a small crosshair symbol. 
Pick a homogeneous area (for instance, a patch of forest), and create the vertices of your 
polygon by ‘tracing’ the boundary and clicking at each vertex.  Finish the polygon feature 
at it’s natural ending point / beginning point by either double-clicking or right-clicking 
and selecting ‘Finish Sketch’, or hitting t F2 key (you can “undo” the most recent vertex 
by clicking the Undo button on the toolbar  ).  Now, pick a more complex shape and 
digitize it… don’t create more than a single polygon by crossing your lines (even though 
ArcMap allows this). Note that these features are ‘isolated’, and don’t share a common 
boundary. 
 
Another neat editing trick is creating polygons that bound each other. First, create a 
polygon as described above. Then, under the ‘Task’ menu, draw down to Auto-Complete 
Polygon. This will allow you to create a set of vertices using the adjacent feature.  Before 
you can start sketching, select the ‘Editor’ tool > ‘Snapping…’, and notice that a window 
appears between the Table of Contents and Display windows (Fig 9) (Note - If you have 
more than one Shapefile loaded in the table of Contents window, you’ll need to tell the 
editor what file’s polygons you want ‘auto-completed’ by selecting that file and it’s 
vertex, edge, and end).  Also click the ‘Edit Sketch’ box, below the ‘Layer’ box, and 
select all three choices (vertices, edges, and perpendicular).   
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Figure 9 .  The Editor > Snapping settings necessary for Auto-Complete Polygon and both edge and vertex 
snapping.  
 
Try it. Notice that the crosshair pointer wants to ‘snap’ to the adjacent feature. We can set 
this ‘snapping tolerance’ by selecting ‘Editor’ > Options > general tab, and filling in the 
box labeled ‘Snapping Tolerance’; set it to 10 pixels for the SAMB photos, and fewer for 
lower resolution data. 
 
Modifying and Deleting Polygon Features 
 
To delete an entire polygon feature, grab the ‘Edit’ tool, click on the feature (the 
boundary will become highlighted), right-click and draw down to delete; you can also use 
the Edit menu and perform the same task on the highlighted feature. 
 
To modify a polygon, simply double click on it and the boundary will change color, and 
the vertices will become evident. Bring the pointer over a vertex and notice that the 
pointer changes to a four-pointed star. Now you can move the vertex to a new location. 
 
To add a vertex, select ‘Modify Feature’ in the ‘Task’ menu, select the polygon that 
you’d like to modify, place the mouse pointer over the location where the new vertex is 
needed, and right-click the mouse and select ‘insert vertex’.  This is very useful for 
adding complexity (detail) to simple polygons. 
 

2.2 Attributing the MUC land Cover Classes 
 

A. Calculating the area of each MUC polygon 
 
Once we’re done creating our digital land cover map, let’s add ‘area’, the area (in square 
meters) of each MUC polygon, and the MUC class code. Are there any other attributes 
that you think are important? If so, we can add those too.   To add area, we either need to 
run an Arctoolbox wizard, or we can d it ‘manually’ (we’ll do both just for practice). 
 
Open Arctool box. Select the ‘Spatial Statistics Tools’ at the bottom. Open utilities, select 
‘Calculate Areas’. Enter the existing shape file name, and a new name for the output. 
This will run a script that automatically calculates the area of each polygon. 
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Another way is to create our own script to calculate polygon area (actually, copy a script 
that someone already wrote in Microsoft Visual Basic (VBA) -- Search Desktop Help for 
Add Field > Data Management).  
 
First, click Editor on the Editor toolbar and click Start Editing.  Right-click the shape file 
layer you want to edit and click ‘Open Attribute Table’.  Right-click the field heading for 
area and click ‘Calculate Values...’ (if there is no field for area values, you can add a new 
field for area by clicking the Options button and selecting Add Field - however, to add a 
new field, you need to exit the editing session).  Check ‘Advanced’.  Type the following 
VBA script in the first text box:  
 
Dim dblArea as double 
Dim pArea as IArea 
Set pArea = [shape] 
dblArea = pArea.area 
 
Type the variable dblArea in the text box directly under the area field name.  Click OK. 
That should add all the polygon areas automatically.  Make sure you check the area 
numbers to see if they make sense. 
 

B. Adding MUC Class Codes 
 
Adding MUC Class codes (attributes) to your polygons is simple and can (like many of 
these exercise elements) be accomplished in a number of ways.  Initially, let’s try coding 
our land cover classes “on the fly”, as we digitize.  First, clear the polygon fill so the 
underlying imagery is visible under the polygon, and show the polygon boundary in a 
high contrast color.  Now, using the ‘Editor’ toolbar, draw down to ‘Start Editing’. Right-
click file, open attribute table, select the polygon of interest, and fill in the appropriate 
MUC class code. Save edits when you’re finished. In this way you can select and code 
quickly. 
 
Another way to add attribute codes is while you’re digitizing the polygon features.  
Simply open the attribute table as you digitize, thus highlighting the active polygon (Fig. 
10), and fill in the MUC code when the polygon is completed. 
 

 
 
Figure 10. The attribute table showing the active polygon, selected and visible to the 
right, in the display window. 
 
Apparently this does not work if you’re using the Auto-Complete polygon task.  
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GLOSSARY 
 
Aerial Photograph (also air photo) – typically a nadir-looking photograph taken from 
either a fixed-wing or rotor aircraft.  Aerial photographs are typically orthorectified and 
georeferenced and thus can be used like a map. 
 
ArcMap – one of several ArcGIS programs, used primarily to organize digital 
geographic data.  
 
ArcGIS – the current ESRI flagship Geographic Information System (GIS) software that 
includes a series of integrated programs to manage, create, process, analyze, and report 
geographic data. 
 
ArcMap – the ArcGIS mapping program, also includes some data creation and analysis 
features. 
 
ArcView – the suite of GIS programs that includes ArcMap, ArcMap and ArcToolbox. 
 
Bands (also channels) – bands or channels are wavelength locations within the 
electromagnetic spectrum.  Visible light is typically divided into three bands (because the 
human eye is only sensitive to these three colors).  The “blue band” exists between 
approximately 450 to 550 nanometers (or .45 to .55 microns); the “green band” exists 
between 550 and 650 nm, and the “red band” exists from 650 to 750 or so. 
 
Coordinate System – a geographic reference system, such as Universal Trans Mercator 
or Geographic Lat/Longs. 
 
Datum (also geodetic datum) – a geodetic datum is a model of the earth. Datums define 
both the size and the shape of the earth, as well as orient coordinate systems that are used 
to map the earth. Referencing geodetic coordinates to the wrong datum can result in 
significant spatial error. See also Map Projections and Coordinate Systems. 
 
Ellipsoid – a 3-dimentional surface, such as the earth, defined mathematically (can be a 
sphere, cigar-shaped, or pill-shaped). Think of it this way… take an ellipse and “spin it” 
about its major axis, and the resulting 3-D “object” is the ellipsoid (see 
http://en.wikipedia.org/wiki/Ellipsoid).  
 
Georeferencing – the process of providing a coordinate system to an (orthorectified) 
image or map. 
 
GLOBE – Global Learning and Observations to Benefit the Earth.  A educational 
program sponsored by NSF, NASA, NOAA and other organizations designed to teach 
science and environmental understanding to K-12 students. 
 
GIS – Geographic Information System. Hardware (computers, GPS receivers, etc.), 
software (e.g. ArcView), and people (you and I) that work together as an integrated 
system to create, management, and disseminate digital geographic data for decision-
making. 
 



ArcMap Tutorial 1.0  page 10 
West Virginia GLOBE, West Virginia View 

GPS – Global Positionaing System. A system of satellites, receives, and software that 
uses trigonometry to determine locations on the earth’s surface.  
 
Ground Reference Data – information on a surface feature or features gathered either 
on-site, from nearby, or from another trusted source such as a recent, high-quality aerial 
photo.  
 
Land Cover / Biometry Protocol – The GLOBE protocol designed to teach remote 
sensing, land use ecology, and elements of biometry (quantitative biology, measuring 
vegetation).  
 
Landsat –  Land remote sensing satellite program dating back to 1972 and currently 
managed by the USGS. Landsat 5 (launched in 1984) and 7 (in 1999) are still operational. 
For a Landsat-specific glossary, see http://landsat.usgs.gov/glossary.php 
 
Orthorectified – ortho means ‘straight, correct, right’, Orthorectification is the process 
of removing distortions in the image due to interactions between the camera, lens, aircraft 
orientation, and the ground surface.  Orthorectification is the process of removing these 
distortions and making an image or photograph geographically “correct”, like a map. 
 
Projection (also map projection) -  the process of transforming (projecting) features such 
as points, lines, and areas or polygons, from a spherical (3-D) surface to a flat (map, 2-D) 
surface, with minimal distortion.  
 
Raster (see also Vector) – a two dimensional array of pixels, typically expressed either 
as columns and rows or as x,y coordinates; any data structure expressed as a grid. A 
“black and white” digital photograph is an example of a panchromatic or grey-scale raster 
image. A natural color digital photographic is an example of a 3-band raster image 
(R,G,B or red, green, and blue). 
 
Remote Sensing – the process of acquiring information on the earth’s surface from a 
distance (usuall aircraft or satellite), processing that information, and analyzing the 
information for decision-making. 
 
Satellite Image – a remotely sensed (usually digital) image of the earth’s surface 
acquired by a sensor onboard a satellite.  
 
Vector (see also Raster) – a geographic data structure using the point, or node and 
respective connecting segment, as the basic building block for representing geographic 
features. Points, lines, and polygons are the three basic types. 
 
WGS 84 (also WGS84)  - an earth-centered datum used by the Global Positioning 
System called the World Geodetic System 1984 or WGS 84.  WGS84 was adopted as a 
world standard from a datum called the North American Datum of 1983 or NAD 83. For 
all practical purposes there is no difference between WGS 84 and NAD 83. 
 
For a more general remote sensing glossary, see the Canada Centre for Remote 
Sensing web page at: 
http://www.ccrs.nrcan.gc.ca/ccrs/learn/terms/glossary/glossary_e.html 


